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1 Introduction
1.1 Contact information

Address: Pico Technology
James House
Colmworth Business Park
ST NEOTS
Cambridgeshire
PE19 8YP
United Kingdom
Tel:  +44 1480 396395
Fax: +44 1480 396296

Web site: www.picotech.com

1.2 Safety warnings
Warning triangle

This symbol indicates that a safety hazard exists on the indicated
connections if correct precautions are not taken. Read all safety
documentation associated with the product before using it.

Safety warnings

USB DrDAQ ground is connected directly to the ground of your computer.  As with
most oscilloscopes and data loggers, this is done in order to minimise interference. 
You should take care not to connect the ground (screw terminal, outer shell of BNC or
exposed metalwork) of USB DrDAQ to anything which may be at some voltage other
than ground, as doing so may cause damage to the unit.  If in doubt, use a meter to
check that there is no significant AC or DC voltage.

For computers that do not have an earth connection (for example, laptops), it must be
assumed that USB DrDAQ is not protected by an earth (in the same way a battery
multimeter is not protected by an earth).

The scope channel on the USB DrDAQ has a maximum input voltage range of ±10 V.
The maximum input voltage for all other inputs is 0 to 5 V. Any voltage in excess
of ±30 V may cause permanent damage to the unit.

Your own sensors should draw no more than 100 mA from the 5 V. The USB DrDAQ is
not limited or protected so overcurrents or short circuits could cause damage to the PC
USB port.

The unit has no user serviceable parts: repair or calibration of the unit requires
specialised test equipment and must be performed by Pico Technology Limited  or
their authorised distributors.

http://www.picotech.com
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1.3 Legal information
The material contained in this release is licensed, not sold.  Pico Technology Limited
grants a licence to the person who installs this software, subject to the conditions
listed below.

Access. The licensee agrees to allow access to this software only to persons who have
been informed of these conditions and agree to abide by them.

Usage. The software in this release is for use only with Pico products or with data
collected using Pico products.

Copyright. Pico Technology Limited claims the copyright of, and retains the rights to,
all material (software, documents etc.) contained in this release.  You may copy and
distribute the entire release in its original state, but must not copy individual items
within the release other than for backup purposes.

Liability. Pico Technology and its agents shall not be liable for any loss, damage or
injury, howsoever caused, related to the use of Pico Technology equipment or
software, unless excluded by statute.

Fitness for purpose. No two applications are the same: Pico Technology cannot
guarantee that its equipment or software is suitable for a given application.  It is your
responsibility, therefore, to ensure that the product is suitable for your application.

Mission-critical applications. This software is intended for use on a computer that
may be running other software products.  For this reason, one of the conditions of the
licence is that it excludes usage in mission-critical applications, for example life
support systems.

Viruses. This software was continuously monitored for viruses during production, but
you are responsible for virus-checking the software once it is installed.

Support. If you are dissatisfied with the performance of this software, please contact
our technical support staff, who will try to fix the problem within a reasonable time
scale.  If you are still dissatisfied, please return the product and software to your
supplier within 28 days of purchase for a full refund.

Upgrades. We provide upgrades, free of charge, from our web site at
www.picotech.com.  We reserve the right to charge for updates or replacements sent
out on physical media.

Trademarks. Pico Technology Limited, PicoScope, PicoLog, and DrDAQ are
trademarks of Pico Technology Limited, registered in the United Kingdom and other
countries.

Pico Technology acknowledges the following product names as trademarks of their
respective owners: Windows, Excel, Visual Basic, LabVIEW, Agilent VEE, HP VEE,
Delphi.

http://www.myhomepage.com/index.html
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2 Product information
2.1 Welcome

Thank you for buying a USB DrDAQ data logger from Pico Technology!

This low-cost measuring device is supplied ready to use with all cables, software and
examples.  Features include:

Built-in sensors for light, sound (level and waveforms) and temperature 
Measure pH - just plug in our standard pH electrode 
Scope input for voltage readings
Sockets for external sensors
Use USB DrDAQ to capture fast signals (for example, sound waveforms)
Digital output for control experiments
Simply plug in to your PC and measure - supplied with both Pico (oscilloscope) and
PicoLog (data logging) software

2.2 Overview
The USB DrDAQ features 14 channels, comprising sensors, inputs and outputs. These
are covered in more detail in Specifications . These connections and sensors cover
measurement of sound, light, voltage, resistance, pH levels, and redox potential.

The Software Development Kit for the USB DrDAQ is compatible with Microsoft
Windows XP, Windows Vista and Windows 7 (32-bit and 64-bit editions).

12
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2.3 Using PicoScope and PicoLog
PicoScope turns your PC into an oscilloscope, spectrum analyser and meter. PicoLog is
a powerful, flexible, advanced data logging package for collecting, analysing and
displaying data. The decision on whether to use PicoScope or PicoLog depends on the
signals you wish to measure.  If you wish to collect fast signals (such as sound
waveforms) then use PicoScope, but if you want to collect data over a long period
(such as plotting battery discharge) then use PicoLog.

2.4 Installing the software
We have designed the PicoScope and PicoLog software to be as easy as possible to
use, even for newcomers to oscilloscopes and data loggers. Once you have followed
the simple steps listed below, you will soon be on your way to becoming an expert. 

1. Install the software. Load the CD-ROM that is included with your scope
device, then click the "Install Software" link and follow the on-screen
instructions.

2. Plug in the USB DrDAQ device. Windows will recognise it and prepare
your computer to work with it. Wait until Windows tells you that the
device is ready to use.
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2.5 Getting started with PicoLog
2.5.1 Using PicoLog for the first time

After installing the software, click the new PicoLog icon ( ) on your Windows
desktop. When PicoLog is first loaded the following screen will appear. 

Under "Help", select the guided tour which will take you through the main functions in
PicoLog. 

Refer to Examples of digital in/out use  for an example of PicoLog and the digital
connections of USB DrDAQ.

32
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2.6 Getting started with PicoScope
2.6.1 Using PicoScope for the first time

1. After installing the software, click the new PicoScope icon on your
Windows desktop.

2. PicoScope will detect your device and prepare to display a waveform.
The green 'Start' button will be highlighted to show that PicoScope is
ready, adjacent to this will be the red 'Stop' button.

3. Try clicking your fingers over the microphone, and the trace on the
screen should react. USB DrDAQ is now successfully installed and
working.

A typical 'finger click' trace

Problems?
Help is at hand! Our technical support staff are always ready to answer your telephone
call during office hours (see our Contact Details ). At other times, you can leave a
message on our support forum or send us an email.

1

http://www.picotech.com/support/
mailto:support@picotech.com
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2.6.2 Displaying channels
To display channels within the oscilloscope window, move your cursor to the channel
buttons which are located along the top of the oscilloscope screen.

     

Add a channel by clicking on the sensor you'd like to activate. In this example we
have activated the the Light sensor, once activated the trace will appear, and the
button will be highlighted in blue.

                     

You can add other channels to the oscilloscope screen by simply clicking the sensor
you wish to view. In this example, we have added Temp. While the trace is running,
put your finger on the temperature sensor and notice the rise in temperature.
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2.6.3 Changing the oscilloscope timebase
The timebase can be adjusted by selecting the drop-down menu shown below. 
Change the timebase to 50 ms/div to change the display as follows:
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2.6.4 Using the trigger
The PicoScope trigger can be used to capture infrequent or one-off events.  As an
example, click your fingers over the microphone: a waveform is displayed but
vanishes as soon as the display updates.  The correct way to capture such a signal is
to use a trigger.

Stop PicoScope (click on the 'Stop' icon at the bottom left hand corner of the window,
or press the space bar) and select a single trigger using the trigger options at the
bottom of the screen.  Press the space bar to start PicoScope and click your fingers
over the microphone.  The single trigger option means that PicoScope stops running
when it has captured a signal.

2.6.5 Adding spectrum views
So far we have looked at the oscilloscope functions. PicoScope allows USB DrDAQ to
be used as a spectrum analyser as well.  The buttons on the top left-hand side control
the oscilloscope, and spectrum views.

 - Oscilloscope view (view signals against time)

 - Spectrum analyser view (view amplitude against frequency)
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2.6.6 Adjusting the RGB LED
Note: When Enable LED Control is active, the LED will not flash when sampling.

The USB DrDAQ units include an RGB LED. The colour of this LED can be changed by
clicking the LED icon above the oscilloscope window. The following drop down will
appear:

Clicking 'Enable LED Control' will show the numerical values for the LED to be
displayed RED:

The colour of the LED is adjusted by dragging the individual colour and brightness
sliders, entering specific RGB values, or clicking within the colour disc.
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2.6.7 Controlling the digital outputs
The USB DrDAQ device includes several digital connections. To activate the digital
outputs, ensure your accessory is connected both to the GND of the USB DrDAQ and
the digital connection you wish to utilise. To operate the connections click the digital
output icon above the oscilloscope window. The following drop down will appear:

Moving any of the 4 sliders to High will activate that digital output. Only connection 1
and 2 are able to output a PWM (Pulse Width Modulation) signal. To do this click the
Digital Out icon above the oscilloscope window and choose PWM in the drop-down for
either digital connection 1 or 2.

This allows adjustment of the PWM Period and Duty Cycle values.

Refer to Examples of digital in/out use  for an example of PicoScope and the digital
connections of USB DrDAQ.

32
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2.7 Specifications and connections
2.7.1 General specifications

Number of channels 14

Maximum sampling rate 100 kHz streaming, 1 MHz block mode

Input overvoltage protection ±30 V

Digital output voltage 3.3 V

Digital output impedance 2.2 kΩ

Output connector USB 2.0

2.7.2 Input, output and sensor specifications

Channel Signal Type Range Resolution Accuracy

Sound waveform Input ±100 ±0.2 Not calibrated

Sound level Input 55 to 100 dBA 1 dBA 5 dBA

Temperature Input –10 to 70°C 0.1°C  @25°C 2°C @ 25°C

Light Input 0 to 100 0.1 Not calibrated

RGB LED Output 16.7 million
colour

8 bit x 3 N/A

pH sensor

Redox/ORP

Input 0 to 14 pH

±2 V @ 1012Ω

0.02 pH

±1.2 mV

Sensor
calibration-
dependent

Resistance Input 0 to 1 MΩ 250 Ω @ 10 kΩ 5%

Scope (voltage) Input ± 1.25 V
± 2.5 V
± 5 V
± 10 V 
with 100 kHz
bandwidth

8 bit 3%

Digital 1 I/O* 2.2 kΩ @ 3.3 V
out, 5 V in

N/A N/A

Digital 2 I/O* 2.2 kΩ @ 3.3 V
out, 5 V in

N/A N/A

Digital 3 I/O* 2.2 kΩ @ 3.3 V
out, 5 V in

N/A N/A

Digital 4 I/O* 2.2 kΩ @ 3.3 V
out, 5 V in

N/A N/A

External 1 Input 0 to 2.5 V 1 mV 1%

External 2 Input As Ext. 1 As Ext. 1 As Ext. 1

External 3 Input As Ext. 1 As Ext. 1 As Ext. 1

Function
generator/AWG

Output DAC 0 to 20 kHz 
0 to 1.5 V
amplitude.
±1.5 V offset.

DC to 100 kHz
running up to
2 MS/s
2 mV

10 mV

*PicoScope supports digital output only, while PicoLog supports digital input and
output.
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2.7.3 Connections

Channel Input Connection

pH / redox BNC connector

Function generator/AWG BNC connector

Scope BNC connector

External sensor 1-3 FCC68 4-pin connector

Resistance input Screw terminal

Digital input/output 1-4 Screw terminal

Connections and labels

Any connection outside of its range can cause degradation to other signals being
recorded. To view the specifications for each channel, refer to Input, output, and
sensor specifications .

External Inputs

Each external input socket has four connections:

Pin Function

1 Input channel with 100k pull-up to 2.5 V

2 Ground

3 Sensor type detect with 100k pull-up to 2.5 V

4 Power up to 100 mA @ 5V (not protected/limited)

Refer to Making your own sensors  for further information.

When using the External connections, sampling above 1 kS/s is not hardware-
supported for basic voltage/resistance inputs.

12

15
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2.8 Channel scaling
The following table gives details of the scaling for each channel.

Channel
number

Input Min Value Max Value Decimal
Places

Units

1 Sound waveform -100 100 1 -

2 Sound level 50 100 2 dBA

3 Scope -10000 10000 0 mV

4 Resistance 0 1000 1 kΩ

5 pH 0 14 2 -

6 Temperature 0 100 1 °C

7 Light 0 100 1 -

8 External 1 Depends on sensor - -

9 External 2 Depends on sensor - -

10 External 3 Depends on sensor - -

11 Digital I/O Off (Low) On (High) - -

12 Digital I/O Off (Low) On (High)

13 Digital I/O Off (Low) On (High)

14 Digital I/O Off (Low) On (High)
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2.9 External sensors
2.9.1 Overview

As well as the built in sensors, USB DrDAQ has sockets for optional external sensors. 
When a sensor is plugged in to the external sensor sockets, the software detects it
and automatically scales readings.  For example, if a temperature sensor is plugged
in, readings are displayed in °C, or if a humidity sensor is plugged in, readings are
displayed in % RH. 

External sensors are optional extras so can be purchased at any time.  For an up-to-
date list of the available external sensors consult the USB DrDAQ web site at http://
www.DrDAQ.com/.

DD100 Temperature Sensor
DD011 pH Electrode
EL029 Reed Switch
DD101 Humidity Sensor
DD103 Oxygen Sensor

2.9.2 DD100 Temperature Sensor

High-accuracy general-purpose temperature sensor with a 2 metre lead. Suitable for
air, surface or liquid measurements.

Range –10°C to +105°C

Resolution (at 25°C) 0.1°C

Accuracy (at 25°C) 0.3°C

2.9.3 DD011 pH Electrode

Before using your electrode, remove the storage bottle.

Size 12 x 120 mm

Operating temperature 0 to 60 °C

Resolution 0.02 pH

15

15

18

19

24

http://www.drdaq.com/
http://www.drdaq.com/
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Using USB DrDAQ with pH Electrodes

The pH input on USB DrDAQ is a very high impedance input that is suitable for use
with any standard pH electrode.  For most applications no calibration is required: just
plug in an electrode and measure.  If, however, you require very accurate pH
measurements, then you should calibrate the probe before use (see below). 

If you are using a pH probe and not getting the results you expect then the most
probable cause is a defective pH electrode.  If cared for properly, pH electrodes will
last for a number of years (see the instructions supplied with the electrode).  If they
are not stored properly, then they will be destroyed in a few weeks.  Trying to
calibrate out errors from a defective probe will not work and may increase errors
further.

pH measurement and temperature calibration

The output from a pH electrode is proportional to absolute temperature (kelvin).  A

temperature difference of 10 C will cause the probe output to change by
approximately 4%.  This is a major source of error with most pH meters and data
loggers. To minimise these errors, a temperature sensor can be connected to Ext 1
and the DrDAQ will compensate for temperature changes. 

Testing pH Electrodes

The best way to test a pH electrode is to use pH buffers (pH 4, pH 7 and pH 10 buffers
are widely available). If you do not have any pH buffers, then distilled de-ionised
water will have a pH near 7 (some still mineral water bottles have the typical pH
printed on the label). Most fizzy (carbonated) cola drinks have a pH in the 2.5 to 3
range.

With the pH electrode connected to USB DrDAQ, display the pH channel using PicoLog.
Measure the pH of each buffer in turn.  Allow 30 seconds for the reading to stabilise
and be sure to wash the electrode in clean water before swapping solutions. If the pH
measured is within 1 pH of the expected value then you can be fairly sure the
electrode is working correctly. If the readings are wrong then the electrode is probably
defective.  Replacement electrodes are available from Pico Technology.

If you suspect that the pH input on USB DrDAQ may be defective, then short out the
BNC connector using a terminator plug. The reading on the screen should be pH 7; if
not, then the most likely reason is that someone has calibrated the probe incorrectly.
Select File/New Settings in PicoLog to delete the user calibration and return to the
default calibration.  If the reading is still wrong then contact technical support.

Calibrating for accurate pH measurements

As described above, calibration is only required when accurate (better than 0.5 pH)
measurements are required. Calibration should be performed just before the
measurements are made.  User calibration information is stored separately in
PicoScope and PicoLog, so if you wish to measure pH accurately with both programs, 2
calibrations will be required.

To calibrate a pH electrode you will require at least 2 pH buffers (pH 4, pH 7 and pH
10 buffers are widely available). Calibration should be performed with the ambient

temperature close to 25 C. A container of clean water is also required to wash the
electrode before moving it from one buffer to another.

1. Connect the pH electrode to USB DrDAQ and display pH using either PicoScope or
PicoLog (depending on which program you are calibrating for).

2. Place the electrode in the first solution and wait for at least 30 seconds for the
readings to stabilise (gently stirring helps).
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3. Make a note of the reading and repeat the procedure for each of the buffer
solutions (do not forget to wash the probe clean before swapping from one buffer to
another.

4. You should now have a table of readings similar to the one below:

pH Buffer value at 25°C Measured value from USB DrDAQ

4.01 4.06

7.00 7.07

10.01 9.92

pH calibration with PicoLog

As already mentioned you will need to note down the measured pH value and compare
it with the actual value to create a lookup table.  Then follow the steps below:

1. Go to Settings and click on Input Channels on the pull-down menu.
2. The converter input type will then be displayed.  Check settings and click OK. You

should now see the USB DrDAQ measurements box. 
3. Select pH and click Edit. 
4. Click Options from the Edit measurement box.
5. Now click on Scaling and select Look up table from the menu box.
6. Enter the real measured pH value below Raw and the actual value in Scaled

(similar to the table in the previous section)
7. Click OK for all open boxes and verify the calibrated pH readings.

Storing pH electrodes

If KCl solution is not available then any pH 4 buffer solution will be suitable for storing
electrodes.  (KCl is recommended because it is the substance inside the bulb of the
electrode.)  Tap water would be acceptable but is not ideal.  Do not under any
circumstances use deionised or distilled water.
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2.9.4 PP066 Reed Switch

A reed switch sensor can be used to detect the presence of a magnetic field such as
that from a bar magnet or an electromagnet.  Alternatively, a simple, single-pole
switch can be connected to terminals inside the EL029.

Size 72 x 45 x 28 mm

Operating range 0 to 99%

Maximum response time 2 ms

The PP066 Reed Switch may be connected to either Ext 1, Ext 2 or Ext 3 on USB
DrDAQ.

To determine the optimum position for the magnet:

Hold the PP066 with its connecting socket towards you and the screw that fixes the lid
facing up.

The best position for the magnet is about half way along (towards the bottom) of the
right hand side of the PP066 case.  The label on the bottom of the PP066 indicates this
position.

When a magnet is in place next to the PP066 the Reed Switch inside the PP066 closes.
This is shown in PicoScope and PicoLog by a change from 100% (switch open) to 0%
(switch closed). Note that this percentage is an indication of the proportion of the
sampling period that the switch is in the open state.

You may use the PP066 to connect a simple, single-pole switch (such as a micro-
switch) to USB DrDAQ. You will need to obtain a switch and some insulated connecting
wire. Remember to keep magnets or magnetic fields away from the PP066 when you
use it with an external switch. Magnetic fields will still make the internal reed switch
operate overriding the open setting of the external switch.

To connect the switch follow these steps:

1. Make sure that the leads from the external switch have about 5 mm of bare wire
to form the connections.

2. Remove the lid.
3. Put the PP066 on a firm flat surface, such as a table top, with the fixing screw

facing up and the connection socket towards you.
4. Unscrew the fixing screw.
5. Lift off the lid of the PP066 and put it and the screw to one side. The lid should

lift off easily.
6. Connect the wire.
7. Find the small terminal block, with two screws in its top, towards the back of the

PP066 circuit board.
8. Loosen the screws in the terminal block. Do not take them out altogether.
9. Thread the two wires from the external switch through one of the holes in the

bottom of the PP066.
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10. Note: If you do not wish to use either of the two holes in the bottom of the
PP066 case, make a hole in the side of the case just big enough for the leads to
pass through. Take care not to damage the electrical components.

11. Leaving enough free wire to make the connection, secure the leads by looping
them around the central boss of the PP066 case.  Alternatively, put a 'tie wrap'
around the leads inside the case and near the hole.  Make sure that the leads are
securely held in the PP066. 

12. Push the bare ends of the leads into the holes in the back of the terminal block. 
There should be one lead in each hole.

13. Tighten the screws in the terminal block and check that the leads are held firmly
in place.  Do not overtighten the screws.

14. Put the lid back on to the PP066.  Make sure it is on the right way round.
15. Tighten the fixing screw being careful not to overtighten it.
16. Check the operation of the external switch.  Connect up the PP066 and make

sure that PicoScope or PicoLog shows near to 100% when your external switch is
open and 0% when it is closed.

2.9.5 DD101 Humidity Sensor

DD101 Humidity Sensor measures humidity using a 'non-condensing' technique.  It
has a short response time and plugs into the external sensor connections of USB
DrDAQ.

Size 72 x 45 x 28 mm

Operating range 20% - 90% Relative Humidity

Overall accuracy Reading ± 10%

Operating temperature 0 - 60 °C

Resolution 0.2% Relative Humidity

Minimum response time 60 seconds with vigorous air movement

Maximum response time 60 minutes in still air

Caution: Do not allow the DD101 sensor to become wet.  The DD101 is a non-

condensing sensor and liquid entering the case (including condensation) may damage
it. 

The DD101 may be connected to either Ext 1, Ext 2 or Ext 3 on USB DrDAQ.

Tips for use of DD101 Humidity Sensors

The sensor responds to humidity changes more slowly in still air.  If you need to
increase the response time, then increase the air flow around the sensor.  For
example, swing the sensor gently on its lead or create a constant draft using a fan. 
Do not blow into the sensor, as your breath is very humid and will produce incorrect
results.  Never allow the sensor to get wet; for example, do not take a cold sensor into
a warm humid environment where condensation may form inside the sensor's case.
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Making accurate measurements

The DD101 will give good readings of humidity and show trends well.  However, if you
need to make more accurate measurements, you will have to calibrate the sensor. 
The calibrated sensor could have an accuracy as good as ± 5% though this depends
on how well the calibration procedure is carried out.

The output of the sensor may vary over time.  For this reason you should calibrate the
sensor regularly (at least once a year).

Basis of the calibration method

Calibration relies on the general physical properties of saturated solutions.  The
humidity above such solutions in closed containers is known quite accurately and is
used to calibrate the sensors.  Chemical salts used for this purpose include potassium
chloride, magnesium chloride and magnesium nitrate. 

Note: The humidity that exists above all such solutions varies with temperature.

The standard solutions may be harmful to your skin, eyes or when
swallowed.  Take all necessary precautions to avoid contact when
preparing and using the standard solutions.

Note: For the highest accuracy you should compare the readings from you DD101 with

the readings from a calibrated 'laboratory standard' reference humidity gauge.

Calibration of the sensor involves:

Preparation of the calibration equipment.
Measurement of the standard saturated solutions.
Creation of calibration data for the USB DrDAQ software.
A check that the calibrated sensor is accurate.

Note: You must measure at least two different standard solutions to provide two or

more fixed points for calibration.

Equipment you will need:

USB DrDAQ with DD101 sensor
Pico DD100 Temperature Sensor
At least two Standard Solutions
A label for the DD101
A test container
An insulated box
A stand for the DD101
[Optional] high-accuracy, calibrated reference 'laboratory standard' humidity gauge

Stand

It is very important that the standard solution does not enter the case of the DD101. 
The solution may damage the electrical components of the sensor.  Therefore the
DD101 needs to be suspended in the test container clear of the standard solution.  A
small stand is the best way to hold the sensor above the solution.  The stand may be
any object (open framework) that is impervious to the standard solution.  Make sure
that the material that your stand is made from is compatible with the test solutions
you intend to use.
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Test container

Your test container should be only just big enough to hold the DD101 and DD100
sensors, the stand, and a small quantity of standard solution (the solution should fill
approximately 5% of the volume of your container).  It will also have to be water-tight
with a seal that allows you to pass the leads for the sensors into the container.

Note: The smaller your container, the more quickly the humidity will stabilise.  You
can reduce the time taken for the system to stabilise by forcing the air in the
container to circulate.  This will require a fan that does not introduce heat into the
container (it must be driven by a shaft or magnetic coupling so that the motor is
outside the container).

 [If you are going to compare the values measured with the DD101 and a calibrated
reference, your container will have to be large enough for the reference sensor too.] 

Make sure that the material that your container is made of is compatible with the
chemicals you are going to use.  If the chemicals react in any way with the container,
the humidity reference will not be correct.

Standard Solutions

The standard solutions may be harmful to your skin, eyes or when
swallowed.  Take all necessary precautions to avoid contact when
preparing and using the standard solutions.

There are several chemicals that have been measured under laboratory conditions to
find out what humidity they provide.  Whichever chemicals you choose, make sure
that the humidity they give is within the operating range of the DD101 sensor (that is,
greater than 20% and less than 90% relative humidity).  You should use at least two
standard solutions to give two fixed points for your calibration.  Standard reference
books such as Kaye & Laby "Tables of Physical and Chemical Constants" (Longman)
give tables with the humidity of standard solutions.  For example:

Compound Humidity at 20 °C

Potassium chloride 85%

Magnesium nitrate 54%

Magnesium chloride 33%

Note: The humidity produced by the standard solution depends on the temperature. 

If the temperature changes from 20 to 21 Celsius this could give a change in relative
humidity of as much as 3% for a nominal 50% value.  This change would be worse for
higher values of relative humidity.

Insulated box

Because the humidity produced by the standard solution depends on temperature, you
should use your test container inside an insulated box.  A domestic cool box (without
the cold blocks) is suitable.
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Preparation

The standard solutions may be harmful to your skin, eyes or when
swallowed.  Take all necessary precautions to avoid contact when
preparing and using the standard solutions.

Prepare your standard solutions before you start the calibration procedure.  Follow the
instructions given by the manufacturers of the solutions you are using.  A slurry of
undissolved chemical in your solution should improve the stability.  Make sure that all
the containers you use for preparation are thoroughly clean before use as
contamination of the solution will alter the humidity.  Do not use tap water to make
up the solution as this is insufficiently pure: use distilled and de-ionized water.  Allow
time for the solution to reach room temperature before use.  Always use fresh
solutions to ensure that the chemicals have not become contaminated or degraded.

Allow the standard solutions and other equipment to reach the same temperature

(ideally 20 C) before you start.

Measure humidity

1. Set up the equipment
2. Clean the equipment.  Make especially sure that the test container is clean; rinse it

out with distilled water.
3. Put the test container into your insulated box.

The standard solutions may be harmful to your skin, eyes or when
swallowed.  Take all necessary precautions to avoid contact when
preparing and using the standard solutions.

Caution: It is very important that the standard solution does not enter the case of the
DD101.  The solution may damage the electrical components of the sensor.

1. Put some of the standard solution into the test container.  The solution should
occupy about 5% of the volume of your container. 

2. Put the stand into the test container.  The stand should give you a clear platform
above the level of the liquid.  Do not allow any standard solution to spill on to the
top of your stand.

3. Put the DD101 and DD100 sensors onto the stand.  [If you are using a calibrated
reference put this in too.]

4. Connect the DD101 and DD100 sensors to USB DrDAQ.
5. Take your measurements
6. Start the PicoLog Recorder software for USB DrDAQ.  Make sure USB DrDAQ is

receiving readings from the sensors on Ext 1  or Ext 2.
7. Seal the test container and close the insulated box (if you are using a fan, start

the fan).
8. Record the temperature and humidity inside the test container for at least one

hour.  You must wait for the temperature to stabilise and the DD101 to provide
correct readings.  This may take up to eight hours if you have used a large
container. 

9. Check that the USB DrDAQ plots for temperature and humidity have been
constant over the last few minutes of your measurements.  [If you are using a
calibrated reference take a reading of this now.  Take care to minimise the
changes in the setup so that the reading does not change significantly.]

10. Save your results.
11. Dispose of the solution as recommended by the supplier of the chemical. 

Remember to take adequate precautions to protect your skin and eyes when
disposing of the chemicals.

12. Do the measurements again for the other standard solutions.  You should end up
with a set of recorded measurements for each standard solution.  Remember that
you must provide at least two fixed points for calibration of the sensor.
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Create calibration data

When the measurements are completed you need to make a written calibration table.

1. From your recorded results find the place near the end of the measurement time
where the readings are most stable.

2. Write down these temperature and humidity readings for the standard solution in
a table.

3. Look up the humidity that the standard solution should give for the temperature
that you have recorded.  Write this value in your table next to the value measured
by the DD101 (the manufacturer of the standard solution should have provided
you with a table for humidities for different temperatures).

4. Fill in entries for all the standard solutions you have measured.

You should end up with a table something like this:

Chemical Measured humidity Standard humidity Temperature

Potassium chloride 81% 85% 20°C

Magnesium nitrate 50% 54% 21°C

Magnesium chloride 30% 33% 20°C

Keep this table for further reference. It will be useful if you have to reset the software
with the PicoLog Recorder New Settings command.

At this stage compare the measured and standard values.  If you find that the
measured values differ from the standard values by more than 10%, then there is
something wrong.  You may have had an unsaturated solution, some contamination in
the solution, inadequate sealing of your test container, or possibly a damaged sensor.
 Check your calibration routine.  If you still get large errors contact Pico for assistance.

[If you are using a calibrated reference this should give values very close to those
quoted for your standard solutions.  If these values disagree by more than a few
percent suspect your calibration procedure.  When the two are in agreement use the
values given by the calibrated reference as the correct figures for your data table.]

Once you have your calibration data you must enter it into the Pico software to
calibrate the sensor:

1. Open the PicoLog Parameter Scaling Dialog
2. Start PicoLog Recorder
3. Click on Settings
4. Click on Input Channels - the DrDAQ Measurements dialog appears
5. Select the input channel for the humidity sensor - for example 'External 1

Humidity'
6. Click on the Edit button - the Edit DrDAQ Measurements dialog appears
7. Click on the Options button - the Parameter Options dialog appears
8. Click on the Scaling button - the Parameter Scaling dialog appears
9. Enter your calibration data
10. Pull down the Scaling Method list and select Table lookup
11. To start your calibration table, click in the white rectangle - the text cursor

appears
12. Type in the value that you measured with the DD101 under Raw.  Type a space

then enter the standard value under scaled. Press the Enter key.
13. Enter all the pairs of measured and standard values that you have to build your

table.  You should end up with two columns   of values.  Note: Your table must
have at least two pairs of values.

14. Click OK to close the dialogs
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15. Click OK to close the Parameter Scaling dialog - the Parameter Scaling
dialog closes

16. Click OK to close the Parameter Options dialog - the Parameter Options
dialog closes

17. Click OK to close the Edit DrDAQ Measurements dialog - the Edit DrDAQ
Measurements dialog closes

18. Click OK to close the DrDAQ Measurements dialog - the DrDAQ
Measurements dialog closes

This completes the entry of the calibration data.

Note: You can remove the calibration data by opening the Parameter Scaling dialog

and setting the drop-down list to 'none'.  If you want to completely delete the
calibration scaling you can either edit and delete the entries in the Parameter Scaling
dialog or use the New Settings command from the main menu.  If you use the New
Settings command all scaling data will be lost.

Check the calibration

To be sure that the calibration has been successful, you must repeat the measurement
stage of the procedure.  When the check measurements have been completed there
should be very close agreement between the measured and standard values (that is,
within 5% of the value).   If this is not the case, check that you have entered the
calibration data correctly and repeat the process.

Once you have successfully calibrated your DD101, write the date on the label and
stick the label on the sensor (do not block the holes in the sensor with the label).

Testing Sensors

You can check whether a sensor is working properly or not by running through the
calibration procedure.  If you find that the sensor values differ from the standard
values by more than 10% you may have a damaged sensor.  In this case contact Pico
for assistance.

2.9.6 DD103 Oxygen Sensor

The DD103 Oxygen Sensor is used to measure the percentage of oxygen in a gas. 
The sensor plugs into the external sensor sockets of USB DrDAQ using the supplied
cable.
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Specification

Sensor Type Galvanic Cell (lead-oxygen with weak acid electrolyte)

Input Range 0 to 100% oxygen

Accuracy (Calibrated) ±3.0% over operating conditions range

Response Times < 15 seconds for 90% response
< 25 seconds for 97% response

Max Humidity 0 to 95% Non-condensing

Operating Temperature 5  C to 40  C

Storage Temperature -15  C to 50  C

Setting up the oxygen sensor

Since the Oxygen Sensor has an output of 0 mV at 0% oxygen, a single-point 
calibration  calibration can be carried out.  The procedure below guides you through
setting up the oxygen sensor to work with PicoLog and calibrating it using the oxygen
in the atmosphere as a reference point (calibration is necessary to use the sensor with
±3% accuracy).

If you have not yet set up USB DrDAQ with PicoLog, do so using the PicoLog help file
before continuing below:

1. Connect the Oxygen Sensor to the socket labelled Ext1 on the USB DrDAQ unit
2. From the File menu, select New settings
3. Click OK
4. Check that USB DrDAQ is selected as the Converter type.
5. Click OK
6. Click Add
7. Under Channel, select External 1.  (The Scaling type will automatically change to

oxygen)
8. Go back to the main monitor view by clicking OK on the two dialog boxes.

USB DrDAQ should be receiving information from the oxygen sensor.  The sensor
should be calibrated using the procedure below.

Calibrating the oxygen sensor

Both PicoLog and PicoScope provide the facility to enter scaling  look-up tables. 
These instructions will concentrate on doing so in PicoLog (for instructions on Custom
Ranges in PicoScope, see the PicoScope help file).

This is the information we have so far:

Raw Values after built
in Scaling File (%)

Calibrated Values
known to be true (%)

0 0

19.9 20.9 (known oxygen in
air at sea level)

Only one more value is needed to complete the look-up table.  If you are measuring
the normal atmosphere then this reading is currently displayed on the PicoLog monitor
view.  Complete the table above with this value and follow the instructions below:

1. Select the Settings | Input channels menu item and click OK
2. Select the Oxygen sensor from the list then click Edit
3. Click on Options, then Scaling
4. From the drop-down Scaling method menu, select Table lookup
5. From the look-up table you completed above, enter these values in the following

format (replace 19.9 with whichever value you read from the monitor view):

35
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0 0
19.9 20.9
(Separate the values above with spaces)

6. Close all of the dialogs by clicking OK in each one

PicoLog's monitor view should now display 20.9% (or very close) for the oxygen
content in air. If so, you've successfully calibrated your USB DrDAQ oxygen sensor.

Storing the Oxygen Sensor

Ensure that the storage temperature and humidity ranges in the specification are not
exceeded. The sensor is not designed for use in liquids and using it in this way will
damage the sensor.

The sensor has a lifetime of 900,000 O2% hrs; in air at sea level the sensor will
operate effectively for over 4 years (this will decrease if the sensor is exposed to high
oxygen concentrations for prolonged periods).

The lifetime of the sensor can be affected by exceeding the storage / operating ranges
and exposure to some gaseous chemicals in high concentrations.  Please avoid the
following: sodium hydroxide, acetone, MEK.



USB DrDAQ User's Guide 27

Copyright © 2012 Pico Technology Ltd. All rights reserved. usbdrdaq.en

2.10 Making your own sensors
2.10.1 Overview

Making your own sensors for USB DrDAQ is quite straightforward provided that you
follow these guidelines.

Your own sensors should draw no more than 100 mA from the 5 V.
The USB DrDAQ is not limited or protected so overcurrents or shorts
could cause damage to the PC USB port.

Designing a USB DrDAQ sensor overview

Each external sensor socket has two channels.  One is an auto-detect to inform the
software which type of sensor it is and the other an analogue input that represents the
sensor reading.

There are four pins on the External inputs.  This view is looking into the Ext socket on
USB DrDAQ in the direction of entry of the plug:

Pin 1 : Signal Input  

Pin 2 : Ground 

Pin 3 : Auto Detect 

Pin 4 : Supply Voltage

Suitable connectors to these external inputs are FCC 68 4/4 plugs.

Alternatively, the USB DrDAQ sensor adapter (break-out box) from Lascells can be
used, part number LA10-716.  The pins are clearly labelled on the box.

The range of the Auto Detect and Signal Input voltages must be between 0 and 2.5
volts.  This is a hardware limitation and any signals outside this range will not be read
by the unit.  Any voltages greater than ± 30 volts fed directly into the device are likely
to damage the unit, and can cause errors with all other USB DrDAQ readings.
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The Signal Input channel has 100 kΩ pull-up resistors to 2.5 V, so that the input can
be either a resistance or a voltage.

Here is a block diagram of a typical USB DrDAQ sensor:

1 = Signal input 
2 = Ground 
3 = Auto Detect 
4 = Power

2.10.2 Powering the sensor
A definition of a sensor is:

A device giving a signal for the detection or measurement of a physical property to
which it responds.

The sensor's properties must be known before work can begin on designing some way
of interfacing it to the USB DrDAQ (sensor scaling).

There are two types of sensor:

Active Sensors: These sensors require power (excitation) from an external source to

generate an output signal. Examples of active sensors include:

Property Sensor Output

Temperature Silicon Voltage / Current

RTD Resistance

Thermistor Resistance

Force / Pressure Strain Gauge Resistance

Acceleration Accelerometer Capacitance

Humidity Capacitor Resistance

Light LDR Resistance

Position LVDT AC Voltage

Passive Sensors: These do not require any power to generate an output.  Typical

examples are:

Property Sensor Output

Temperature Thermocouple Voltage

Force/pressure Piezoelectric Voltage

Position Variable resistor Resistance

Light Intensity Photodiode Current
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When selecting a sensor for an application you should consider the following:

The input is 0-2.5 V.

1. Is the sensor Active or Passive?  If Active then can it be powered by the USB
DrDAQ?

2. What is the output of the sensor?  Can the sensor be plugged directly into the USB
DrDAQ?

3. Is the sensor already available on the USB DrDAQ, or are there more suitable
sensors out there?

2.10.3 Scaling
Sensor Scaling - Software

It is necessary to create a scaling file so that the software can extract details about
the sensor.  Details on creating scaling files can be found in the DrDAQ Scaling Files
(.DDS)  topic.  Scaling in software also provides an opportunity to perform a
calibration  on the sensor, which can compensate for any manufacturing
irregularities.

Sensor Scaling - Hardware

With both these types of sensors it is essential that the USB DrDAQ displays an
accurate representation of the property to be measured.  There are many factors to
take into account when designing scaling circuitry:

Sensitivity

The USB DrDAQ has 12-bit resolution over the 0 to 2.5 V input range.  This means the
sensitivity is:

2500 mV / 2^12 = 0.611 mV

To make the most of the resolution, the signal output from the sensor should use as
much of the input range of the USB DrDAQ as possible.

Linearity

As illustrated below, not all sensors have a linear response.

Linear Response An Example of Non-Linear
Response

A linear response is one whose output-versus-input graph is a straight line.  An
example of this type of response is a photodiode.

Note: a non-linear response curve cannot be calculated using a simple y = ax + b
formula. An example of this type of response is an LDR.

33
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Offsets

The above linear and non-linear responses could have a voltage, current, resistive or
other type of offset that may need taking into account.  It is quite usual to see offsets
in output signals from sensors.

Sensor output

The USB DrDAQ requires an input signal in DC volts or resistance.  The sensor in
question could give an output in other units such as resistance, current or AC volts.

Drift

It is possible that the sensor output drifts over time.  This may involve recalibration of
the sensor at set time intervals, or some self-calibration.

Hysteresis

The sensor may give a different output value when rising to a voltage than when
falling to a voltage.  This is difficult to eliminate and should be taken into account.

Once the sensor has been selected and all of the above has been considered, the
design of some scaling circuitry can begin. There are many ICs on the market that can
be purchased cheaply that deal with the above potential problems.  Look into these
before re-inventing the wheel and spending expensive development time designing a
circuit that can be purchased for a few pounds.
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Some simple scaling examples:

Example 1: Interfacing a Resistive sensor

Notes:

Light-dependent resistor (LDR) can be
used in conjunction with a fixed
resistor to measure light level.  A
suitable LDR sensor can be obtained
from Maplin Electronics (part number
N53AY). A resistor (R) of around 500k
is suitable.

Example 2: Measuring 4-20 mA Current

Notes:

4-20 mA output is the industry
standard for interfacing between a
control centre (data logger) and a
remote process such as a sensor.  For
this reason 4-20 mA sensors are very
common. 

For relatively small currents a simple
shunt resistor can be used to convert
the current into voltage which the
DrDAQ can then measure. 

A suitable resistor (R) for the USB
DrDAQ is 120 ohms. This would give
(using Ohm's Law): 

0.4 volts at 4 mA
2.4 volts at 20 mA

P = VxI

Therefore >50 mW resistor required.
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Example 3: Measuring 10 volts

Notes:

This is a simple circuit that uses a
potential divider to reduce the voltage
going into the USB DrDAQ by four. R1
= 3k & R2 = 1k The resistors are
calculated using Ohm's Law, V=IR.

Auto-Detect

Auto-detect resistor is placed between Ground (Pin 2) and
Signal Detect (Pin 3). The value of the resistor should be
selected from one of the following common values: 1k0, 2k2,
3k3, 5k6, 7k5, 10k. It is necessary to have an auto-detect
resistor so that the software can automatically scale the input
signal into the property that it represents.

2.10.4 Examples of digital output use
PicoScope

The following is a short example of how to activate an LED via a digital output on the
USB DrDAQ using the Mask and Alarm functions of PicoScope. With USB DrDAQ
connected and PicoScope open:

Connect the LED to the GND connection on the USB DrDAQ and digital connection 2
(refer to Connections).
Note: Any digital connection can be used but we are using 2 in this example).
Within PicoScope, activate the Temp channel only (refer to Displaying Channels )
.
Under the Tools menu, choose Masks>Add Masks.
Choose Mask of Temp within the Available Masks area, or click Generate if it doesn't
show in the Library list.
Click Apply and choose OK.
Right click the oscilloscope window and choose Masks>Edit Mask.
Within the mask dialogue, adjust the two low values to 28°C.
Right click the oscilloscope window and choose Masks>Exit Mask Edit.
Under Tools menu, choose Alarms.
Under Event, choose Mask(s) Fail (ensure it is enabled).
Choose Add.
Under Action menu, choose Digital Output.
Set Chann to Digital Output 2, and High.
Choose OK.
Click Apply and choose OK.
Start the trace and place the tip of a finger onto the Temp sensor on the USB
DrDAQ. The trace should rise, and upon overlapping the mask, the LED connected
to digital connection 2 should illuminate.

7
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PicoLog

The following is a short example of how to activate an LED via a digital output on the
USB DrDAQ using the Alarm function of PicoLog. With USB DrDAQ connected and
PicoLog open:

Connect the LED to the GND connection on the USB DrDAQ and digital connection 2
(refer to Connections).
Note: Any digital connection can be used but we are using 2 in this example).
Choose File>New settings.
Click OK.
Click OK.
Choose Converter type: DrDAQ (USB).
Click OK.
Click Add.
Next to Channel, choose Temperature.
Choose Options.
Choose Alarm.
Select Enable Alarm.
Enter the Upper threshold 28°C.
Select Digital Output 2.
Click the next four OK buttons.
Place a finger tip on the Temp sensor and an alarm will trigger once the
temperature goes above the upper threshold entered earlier. When this happens
the LED will illuminate, along with the red alarm icon in PicoLog. When you remove
your finger, the LED will extinguish (once the temperature drops back below the
upper threshold value).

2.10.5 USB DrDAQ scaling files (.DDS)
The DrDAQ driver has built-in scaling for each of the built-in and Pico-supplied
sensors.  You can incorporate scaling for your own sensors by adding a file called 

scaling.dds  (where 'scaling' can be replaced with a name of your choice). This

file will contain the details of your sensor.

Each scaling file may contain more than one set of scaling data.  Each scaling must
have a unique scaling number, contained in the [Scale...] section heading.

A set of typical entries from a .DDS file is shown below:

[Scale1]
Resistor=1
LongName=CustomTemperature1
ShortName=TempC
Units=C
MinValue=-40
MaxValue=120
OutOfRange=0
Places=1
Method=0
IsFast=Yes
NoOfPoints=32
Raw1=2.385
Scaled1=-30
...
Raw32=1.32
Scaled32=100

[Scale2]
Resistor=2.2

33
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LongName=CustomTemperature2
ShortName=TempF
Units=F
MinValue=32
MaxValue=160
...
[Scale3]
Resistor=3.3
LongName=CustomLight
ShortName=Light
Units=lux
MinValue=0
MaxValue=20000
...

The meanings of the terms in the .DDS file are as follows:

[Scale1]

A unique number, from 1 to 99, to identify this entry.  (Pico-created numbers are
from 100 upwards.)

Resistor=1

The ID resistor value in kiloohms.  In this example "1" represents 1k, "2.2"

represents 2k2 and so on.

For external sensors, this resistor should be fitted in the sensor.  You must use one
of the following resistors: 1k0, 2k2, 3k3, 5k6, 7k5 or 10k.  The resistor must be 1%
tolerance or better.

For internal sensors, use the following 'virtual' resistor values:

1 Sound Waveform 1200

2 Sound Level 1300

3 Scope (voltage) 1500

4 Resistance 1600

5 pH 1400

6 Temperature 1100

7 Light 1000

LongName=Temperature

Used in PicoLog

ShortName=TempC

This field is not used by USB DrDAQ running PicoScope or PicoLog.

Units=C

Displayed on graphs

MinValue=-40
MaxValue=120
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Note: For PicoScope these values will determine the maximum and minimum
values displayed in Oscilloscope View.  For PicoLog these values determine what
Maximum range is displayed in the Graph View (set in the Graph Options dialog).

Places=1

Number of decimal places. The options are 0, 1, 2 and 3.  With places=1 the value

15.743 would be returned as 157, meaning 15.7. With places=2, the same value

would be returned as 1574.

Method=0

This specifies the scaling method. 0 specifies table lookup and 1 specifies linear
scaling.

Offset=0
Gain=1

These are the offset and gain values for linear scaling.

OutOfRange=0

This specifies what to do if the raw value is outside the range of the table lookup.
The options are:
0 - treat as a sensor failure
1 - clip the value to the minimum or maximum table value
2 - extrapolate the value using the nearest two table entries.

ScopeRange=1.25V

This is used when scaling the scope channel. It specifies the range of the scope
channel that should be used. Possible values are 10 V, 5 V, 2.5 V, and 1.25 V.

NoOfPoints=32

This is the number of table lookup points.

Raw1=2.385

Raw value for the first point in the look up table. The value is in V (volts) and
should not be greater than 2.500 V, except when using the scope channel when the
minimum and maximum values correspond to the selected range.

Scaled1=-30

Scaled value for the first point in the look up table. The units are specified by the
units parameter.

2.10.6 Calibration
You can adjust the calibration of the USB DrDAQ and its sensors using the Scaling
Files . However, all input channels of a USB DrDAQ are calibrated during
manufacture.

Calibration involves measuring a known value (such as the temperature of boiling
water, or the resistance of a known resistor, or the values shown by a calibrated
sensor) then converting these values into the units you need. 
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Linear

Single-Point Calibration

When calibrating a sensor with a linear response curve it may only be necessary to
perform a Single-Point Calibration.  This only occurs in one circumstance:

One pair of values is known - for example on the USB DrDAQ oxygen sensor.  The
sensor is known to output 0mV at 0% oxygen content.  Therefore we only need to find
one other pair of values.  All we are doing here is changing the gradient of the
response curve.  See the Oxygen Sensor  description for a full example.

Two-Point Calibration

A two-point calibration should always be carried out if possible, since it is the most
accurate calibration method for a sensor with a linear response curve.

It is important that the readings are taken for both extremes of the sensor's 
operating input range to ensure accuracy.  For example:

A temperature sensor has an input range of -200 °C to +200 °C but we only want to
use it between -5 °C and 110 °C.  Therefore this will be its operating input range. 
The first calibration point should be close to -5 °C, so the sensor will be placed in
melting ice, which is known to be 0°C.  The second calibration point should be close to
110 °C, so the sensor will be placed in boiling water, which is known to be 100 °C.

It is rare that such a convenient range is available, but the principle of two-point
calibration stays the same.

It is important to distinguish between the operating range and the full input range of
the sensor, since it would be far more difficult to calibrate the sensor between -200 °C
and +200 °C and would yield no accuracy benefit for the user between -5 °C and
110 °C.

24
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Non-Linear

Multi-point Calibration

You will need more than two points to describe a non-linear response curve, and
therefore you will need to create a look-up table experimentally.  Since you will be
measuring a series of readings at unconfirmed intervals, the only way to know the
calibrated value is to perform the same measurement with both the sensor you are
calibrating and a sensor which you know has already been calibrated.  Create a table
of raw and scaled values similar to below.

x (raw) new sensor y (scaled) calibrated sensor

0 0

5 8

10 12

15 14

20 15

Both PicoLog and PicoScope have the facility to manually enter look-up tables (see the
respective help files). You can also make a more permanent reusable scaling table
with USB DrDAQ Scaling Files (.DDS) .33
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3 Software updates
Our software is regularly updated with new features. To check what version of the
software you are running, start PicoScope or PicoLog and select the Help | About
menu.  The latest versions of PicoScope can check for updates automatically and will
advise you if an update is available. The latest version of all our software can be
downloaded free of charge from the Pico Technology web site at http://
www.picotech.com/. Alternatively, the latest software can also be purchased on CD.

To be kept up-to-date with news of new software releases join our e-mail mailing list.
This can be done from the main web site at http://www.picotech.com/.

http://www.picotech.com/
http://www.picotech.com/
http://www.picotech.com/
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4 Glossary
Analog bandwidth. The input frequency at which the measured signal amplitude is
3 decibels below the true signal amplitude.

Buffer size. The size of the oscilloscope buffer memory, measured in samples.  The
buffer allows the oscilloscope to sample data faster than it can transfer it to the
computer.

Device Manager. Device Manager is a Windows program that displays the current
hardware configuration of your computer. On Windows XP or Vista, right-click 'My
Computer,' choose 'Properties', then click the 'Hardware' tab and the 'Device Manager'
button.

Driver. A program that controls a piece of hardware. The driver for the oscilloscopes
is supplied in the form of a 32-bit Windows DLL, usbdrdaq.dll. This is used by the

PicoScope software, and by user-designed applications, to control the unit.

Maximum sampling rate. A figure indicating the maximum number of samples the
oscilloscope can acquire per second. The higher the sampling rate of the oscilloscope,
the more accurate the representation of the high-frequency details in a fast signal. 

Oversampling. Oversampling is taking measurements more frequently than the
requested sample rate,  and then combining them to produce the required number of
samples.  If, as is usually the case, the signal contains a small amount of noise, this
technique can increase the effective vertical resolution  of the oscilloscope.

PC Oscilloscope. A virtual instrument formed by connecting a PicoScope oscilloscope
to a computer running the PicoScope software.

PicoScope software. A software product that accompanies all PicoScope
oscilloscopes. It turns your PC into an oscilloscope, spectrum analyzer.

Redox potential. A measure in volts of the affinity of a substance for electrons.

Timebase. The timebase controls the time interval that each horizontal division of an
oscilloscope view represents. There are ten divisions across the oscilloscope view, so
the total time across the view is ten times the timebase per division.

USB 2.0. Universal Serial Bus. This is a standard port used to connect external
devices to PCs. The port supports a data transfer rate of up to 12 Mbps with USB
DrDAQ. 

Vertical resolution. A value, in bits, indicating the precision with which the
oscilloscope converts input voltages to digital values.  Oversampling  (see above)
can improve the effective vertical resolution.

Voltage range. The range of input voltages that the oscilloscope can measure. For
example, a voltage range of ±100 mV means that the oscilloscope can measure
voltages between -100 mV and +100 mV. Input voltages outside this range will not
damage the instrument as long as they remain within the protection limits stated in
the Specifications  table.
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